
i of iii 

 

 

 

 

 

 

 

 

 

 

A user guide for editing 

seed and seedling images in 

Adobe Photoshop. 

By Jo Jones, PhD, MRSB 

jojimages@littleloon.ca 

 06 April 2020 

Copyright Jo Jones, 2020 

Using Adobe Photoshop to generate a fully focussed single image from images generated 
using a Nikon camera system, a StackShot controller, Zerene Stacker software and Adobe 
Photoshop CS6. 

This guide is provided free for information and training purposes only.  

No responsibility is taken for any errors, omissions or financial loss due to application of the information provided.  

The document and images remain the property and copyright of Jo Jones. 



Page 1 of 19 

CONTENTS 

Overview           1 

1.0 Editing in Adobe Photoshop CS6        2 

1.1 Getting started in CS6         4 

1.2 Adjusting any colour aberrations        8 

1.3 Editing the background         9 

1.4 Sharpening the image         15 

1.5 Adding a text layer         17 

 

Useful contacts           19 

 

  



 

Page 2 of 19 

Using Adobe Photoshop to generate a fully focussed single image from images generated using 
a Nikon camera system, a StackShot controller, Zerene Stacker software and Adobe Photoshop 
CS6. 

 

Overview 

This user guide describes how to achieve high quality images after editing in Adobe Photoshop CS6 from a series of 
images each with a different focal point using a Nikon camera and lenses, a StackShot controller for moving the 
camera remotely and Zerene stacking software.  

The final image is composed of many individual frames which have been put together (stacked) using the Zerene 
Stacker software package. 

Final editing using Adobe Photoshop CS6 to correct any colour aberrations and to edit the background before adding 
a scale and a copyright complete the process. To describe the editing process in CS6 the use of screen shots is used 
to illustrate each process. 

Image resolution is always important and a compromise with the file size that websites can currently easily use, see 
page 19 for details. 

This guide is written by me using my experience and any opinions expressed in this guide are my own personal 
opinions. All the equipment is my own, I take nature and wildlife photographs and also work on a contract basis 
delivering training or taking and editing images of seeds. Any camera system, stage controller and stacking 
software package can be used and although I use Adobe Photoshop CS6 this guide should be applicable for use 
with Adobe Photoshop CC now available by subscription from Adobe.com. 

 

TIPS  

Throughout this guide I have included tips that I have found by my experience to be useful, these are shown by the 
accompanying symbol, hopefully you will find these useful. 

 Always take a few test images before embarking on a whole series to test out the lighting.  

 Include with these images some shots with a measurable scale, such as a ruler for later reference. 

 A scale can be added to the image during editing in CS6. 

 Save often and make a copy of the final image 

 

 

Note:  All the software programs and process are written for a Windows PC. 
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1.0 Editing in Adobe Photoshop CS6 

ALWAYS duplicate the image as a precaution to an unrecoverable error before editing and change the file name to 
avoid overwriting your original image. This is simple if using Adobe Bridge as there is a Copy and Duplicate function. 
Click on the image file to highlight it, right mouse click and the drop down menu includes the options to Duplicate, 
Copy or Copy to. 

Note: Abbreviations used in the following text 

Photoshop CS6   CS6 

Left and right mouse (buttons) LHM and RHM 

Central scroll (wheel) on mouse CSM 

 

CS6 is an excellent editing program. One of the strengths is that all editing can be non-destructive by working in 
Layers and with Masks. Working in layers also makes it easy, for example, to change the background colour or add 
text, such as a scale and copyright. If the edited image is saved as a TIFF or PSD all the layers are preserved in the file 
format making it easy to make changes later if necessary.  

 

 I keep two copies of my completed images (as well as a copy of the unedited original), one as a TIFF and one 
as a JPEG.  

 

 

The default Zerene file naming format for a completed stacked image uses both the date and 
time in the file name, for example 2019-06-17-11.08.58 ZS PMax. It can be opened only once in 
Photoshop. Any subsequent editing that you complete within CS6 will not be saved unless the 
file name is changed to a more conventional format after opening the file in Photoshop for the 
first time, for example, renaming to chive_01 will allow the file to be saved and reopened as 
normal. 

 

 I save the image generated by Zerene as a TIFF file and as the Zerene default file package. 
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1.1 Getting started in CS6 

There are usually several methods in CS6 for getting to the same point, for example there are at least two ways of 
making a layer. The methods used here are the ones I find the easiest to use. There are probably many ways of 
getting to the same point. 

 

 SAVE often. You never know when or if a data disaster will strike. 

 

The editing process will now be shown using screen shots of editing images of a flowering Allium taken and stacked 
together using the Zerene software. 

 

Double click on the Photoshop icon to open the program to set your preferences. To amend and apply some 
preferences Photoshop may need to be restarted. 

It is important to set your preferences for file handling and editing. Figure 1 shows the main screen and some of my 
preference selection for editing, selected by LHM Edit ˃ Preferences 

 

Figure 1. Main screen in Photoshop CS6 showing my main preferences for editing in CS6. 

 

 

Open the image file from Bridge by highlighting the file and doubling clicking the LHM. CS6 will open (Figure 2). In 
order to edit the image an editable layer must be present and when the image is first opened, the background layer 
is not editable. 
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Figure 2  Image first opened in CS6. 

 

The following figures (Figures 3 to 18) show the series of editing functions and the process that I regularly follow. 

 

I edit images in Photoshop using Layers, these are non-destructive and the effect of a layer can be easily seen by 
making that layer invisible. Ellen and Josh Anon in Photoshop CS5 for Nature Photographers describe layers as the 
following: 

If you place two prints of the same size on top of each other, only one print is visible, although you know it is there. If 
you make a hole in the top print then some of the bottom print can be seen. The two prints can be regarded as layers 
and in Photoshop each layer is called a pixel layer.  

Just to complicate things, Photoshop has two kinds of layers, pixel layers and adjustment layers. Adjustment layers 
do not have any pixels but are the layers used for changing the appearance of a pixel layer. For example the Hue / 
Saturation adjustment layer can increase or decrease specific colour saturation. This is similar to using a filter (such 
as a polariser) in front of your lens before taking an image. 

If you work in layers then each time an adjustment is made only that layer is altered, each time a pixel is altered it 
can be ‘damaged’ and loses quality. Therefore working with layers ensures that this does not happen and your 
original image remains intact. Layers can be made visible or hidden and ‘holes’ can be punched, colours adjusted 
whilst keeping the integrity of the original. Layers are laid on top of another, with the top layer being visible. 

 

When an image is opened for the first time only one layer, the background layer is visible. To enable non-destructive 
editing another layer must be ‘constructed’ from this layer. 

A Layer must first be made from the Background layer of the unedited opened image. This ensures that all editing 
will be performed non-destructively on one or more subsequent layers. 
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To make a layer visible (or to hide it), click on the ‘eye’ icon next to that layer in the Layers panel. When the ‘eye’ is 
seen the layer is visible, when the ‘eye’ is not visible, the layer is hidden from view. 

 

 

Make a Layer from Background by either LHM on the Layer tab ˃ New ˃Layer from Background 

Or you can use the Layer symbol,  located at the bottom of the Layers panel (Figure 3). 
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Figure 3a.  Creating a Layer from Background enabling all subsequent editing to be on a non-destructive layer. 

 

Figure 3b. 

 

Once you have an editable layer you can then correct any colour aberrations by adding a Hue / Saturation Layer 
(Figure 4). 
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1.2 Adjusting any colour aberrations 

Again, as before, either use the Layer tab or the Layer symbol button and the Adjustment Layer menu appears. 

Figure 4a. Hue / Saturation for colour adjustments 

 

Figure 4b. Use the hand / finger symbol to select the colour you wish to correct, use the LHM to increase or decrease 
the saturation as required moving it to the left or right whilst holding it down. 

 

After any colour correction the background may need to be changed. One process for completing this is outlined in 
the following figures (Figures  5 to 12).  
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1.3 Editing the background 

Firstly use the Quick selection tool (fourth tab down on left vertical tool bar) to draw an outline around the subject. 
The brush size in pixels can be changed in the tab that appears when the brush is in use. A small brush will take 
longer but is more accurate. Care taken to draw around the image can save time in later editing steps.  

Go to ˃  Select on the main tool bar and using LHM click on Inverse (Figure 5).  

When inverse is selected the object around which you used the selection tool will not be edited, it is therefore literal 
in that it is the Inverse of your selection. 

 

Figure 5.  Quick selection tool and invert image 

 

 

 

Click on   ˃ Refine Edge in the second row tool bar from the top of the page. 

The Refine Edge box appears (Figure 6). In the View Mode box the user can change the appearance of how the image 
looks whilst editing in Refine Edge mode.  

 My preference is to Show Overlay and have the Radius showing. The values for radius, smooth, feather, 
contrast and shift edge may vary for each subject. My default output is always a New Layer with a Layer 
Mask. 

 

I prefer to see the features of the refine edge tool clearly, try out the options and find what works for you. 
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Figure 6a.  Refine Edge section parameters with the output image as a new layer with a layer mask. 

 

Figure 6b. After further refinement using the Edge Detection and Adjust Edge functions only the outline drawn by 
the Quick Selection tool can be seen but the subject is still there, it is hidden from view. In the Layers panel the 
image plus a black and white silhouette is visible.  

 

 

The next step is to choose the background colour and put this in place behind the subject (Figure 7). 
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The outline drawn by the Quick Selection tool can be seen but the subject is still there, it is hidden from view. In the 
Layers panel the image plus a black and white silhouette is visible. Layer 0 containing the subject is not selected and 
therefore not visible yet. 

 

On main tool bar Click Layer ˃  New Fill Layer ˃ Solid colour 

 

 

Figure 7.  Adding the background colour layer. 

 

 

 

The New Layer box appears      ˃      click on the box to   Use Previous Layer to Create Clipping Mask (Figure 8). 
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Figure 8 . New Layer box with Use Previous Layer to Create Clipping Mask. 

 

After clicking OK the Colour Picker box appears, this is where you can choose any colour for the background (Figure 
9). 

Figure 9.  Colour Picker box showing a wide selection of colours. 

 

The resultant selection is shown in Figure 10 and after selecting Layer 0 in the Layer panel. 
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Figure 10. Uniform colour background added now with subject visible after selecting Layer 0. 

 

Using the hand function (left hand vertical tool bar) and CSM to zoom in closely, there may be some further editing 
to tidy up around the edges. Figure 11 shows a dark area that should not be in the final image. 

Figure 11. An area where further editing is required before the image is completed. 

 

The tidy-up around the edges is achieved easily now that we can use the Layer Mask option (our output from Refine 
Edge, Figure 6). This allows us to paint around areas using just black and white, white paints on the background 
colour of whatever colour option was chosen and black reveals the image underneath. 
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LHM on the Layer Mask (black and white silhouette) 

Click on the Brush tool (left hand vertical tool bar) 

Click on Windows (main tool bar) ˃ Swatches 

After the use of the black and white colours to paint around the edges or where it is necessary, Figure 12 shows the 
completed image. Again brush size (and shape) can be selected from the brush selection at the top. 

Figure 12. Completed image. 
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1.4 Sharpening the image 

All that is required now is to Sharpen the image slightly, although this may not be required. Go to Filter (main tool 
far) and LHM Sharpen. There are several methods to choose from, all have merits but I use Smart Sharpen. If you tick 
the Preview box then the effect of your sharpening can be seen. Adjust the values as for amount and radius as 
required (Figure 13). 

Figure 13a. The Smart Sharpen box is selected from the Filter menu on the main tool bar. 

 

Figure 13b. 

 



 

Page 16 of 19 

After Sharpening the only functions left are to add a scale and a copyright (if needed). Before adding any text I would 
strongly advise that the image is saved as a TIFF (Figure 14) with layers. It is possible that for a future use the 
addition of a scale and copyright are not needed, if you have two versions saved then you do not need to start again. 
It is also easy just to provide the version required without any ambiguity. 

 

Note: When using layers you can select and deselect layers so that they are visible so saving two versions may not 
absolutely necessary.  

 

Figure 14. Saving as a TIFF with layers will result in a large file but all data is available for future edits. 

 

 

The advantage of saving as a TIFF with all the layers intact is that maybe you wanted to change the background 
colour for a poster. It is easy to do so by just LHM on the colour panel of the Colour Fill layer. A new colour picker 
box appears, choose your colour and the background is changed instantly (Figure 15).
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Figure 15. Background colour change is easily achieved with a file saved as a TIFF with layers. 

 

1.5 Adding a text layer 

Click on the Horizontal Text Tool (T on the left vertical tool bar), the properties of the text ‘brush’ can be seen on the 
second tool bar at the top. These are almost the same as in Word. A text cursor also appears where the mouse is 
hovering over the image, position the text cursor where you want to add the text and LHM. You can now write in the 
required text, when finished click on the tick that appears. You can resize the text by highlighting the text and using 
the box at the top to change the size as in any application that uses text (Figure 16). 

Figure 16. Added text on the final image. 
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The text layer is seen in the layers panel on the bottom right hand side above the Hue / Saturation layer. Adding a 
scale is almost identical, with a line drawn instead of the text, although the units of the scale will be added as text. 
The Line Tool is found just above the Hand on the vertical tool bar (Figure 17). Each line drawn will be shown as an 
individual text layer, for example a straight line with two indents will result in three text layers. 

Figure 17. Line tool on the vertical tool bar located above the hand tab. 

 

A grid is an option that you can use to help draw a straight line and also to calibrate any units. The grid is accessed 
from the View tab. Properties for the grid are set in the preferences page (Figure 18).  

Figure 18. Grid selection to facilitate drawing straight lines for a scale. 
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After making all your changes SAVE the version with a different name / version number. This will ensure that you do 
not overwrite a version without a scale and copyright. 

 

Before saving your final version check that the file size and resolution are sufficient for your purposes. Both these 
functions are found using the Image tab on the main tool bar under the Image Size item. For publishing on the web I 
provide a JPEG file at a resolution of 72ppi (pixels per inch) with the picture size of 600 x 400 pixels. For some 
websites I provide an 1800 x 1200 pixels image at 72ppi. Other than this I save as a TIFF file at the highest resolution 
and size possible for my camera (a resolution of 300ppi and my original image size). Although CS6 can ‘add’ pixels 
when resizing, and other CS6 PlugIns are available that will resize an image with minimal loss of image quality, it is 
always better not to. 

 

 

These are only a few methods for editing in Photoshop. There is no right or wrong way to do anything. I have shown 
one way to hopefully get you started. Photoshop is complex and extensive and there are several ways to achieve the 
same objective. It is a complete editing program. This guide only touches the surface of what the program can do 
and covers the basics for editing. There are many excellent books / manuals that are available both in electronic 
format and as hard copy. 

 

Useful contacts 

Product Company Website (www.) 

Adobe Photoshop (software) Adobe Adobe.com 

Zerene Stacker (software) Zerene Systems zerenesystems.com 

Nikon camera systems and software Nikon Nikon.com 

Canon camera systems Canon Canon.com 

StackShot controller Cognisys cognisys-inc 

Macrofocusing rails Novoflex novoflex.com 

Quick release platform, plates, plamps Wimberley tripodhead.com 
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